
5

This chapter describes the various windows, toolbars and buttons you will see in Standard &
Poor’s Research Insight. It shows you how to navigate through Research Insight by describing
the elements of:

• The Welcome to Research Insight window

• The Research Insight desktop

• The Research Assistant

• The Report Assistant

• The Chart Assistant

• The Run Assistant

• The Look Up List

Chapter 2
Navigating Research Insight
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Welcome to Research Insight Window

The Welcome to Research Insight window is your entry to the basic functions of Standard &
Poor’s Research Insight. When you click a button or corresponding text with your mouse, you
will be taken to the many different functions of Research Insight. If you do not want this
window to automatically display when you enter Research Insight, click the Display on
Startup check box to turn off the default setting. Below is a description of each button on the
Welcome to Research Insight window:

Research Assistant: define your screening criteria, then develop custom reports and 
charts, or access pre-defined reports or charts.

Report Assistant: develop custom reports, then define your screening criteria.

Chart Assistant: develop custom charts, then define your screening criteria.

Company Highlights: run a financial highlights report for one or more companies.

Library: retrieve Business Descriptions and Trends and Projections.

Open Screen: open pre-defined screens, or begin developing a new screen.

Open Report: open pre-defined reports, or begin building a new report.

Open Chart: open pre-defined charts, or begin building a new chart.

Open Set: open pre-defined sets, or begin developing a new set.

Prices, News and Headlines: accesses Real Time for current prices and news.

Closes the Welcome window and displays the Research Insight desktop.
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Research Insight Desktop

This desktop provides another way to access all the features of Research Insight. It displays when
you click Close from the Welcome window, or whenever you click Cancel in the Research
Assistant. To return to the Welcome window click the        (Welcome) button or select
Welcome to Research Insight from the Help menu. Descriptions of the buttons on the
left side of the desktop are displayed above, and the buttons on the toolbar at the top of this
window are described below. 

Create a new report, chart, screen or set

Open an existing report, chart, screen or set

Print

Copy

Cut

Welcome Window

Run a report, chart, screen or set

About Research Insight

Context sensitive help

Look Up

Paste

Save

Report Assistant:
develop custom
reports, then define
your screening criteria

Research Assistant: define your screening criteria, then
develop custom reports and charts, or access pre-defined
reports or charts.

Open Set: open pre-
defined sets, or 
begin developing a
new set.

Open Chart: open
pre-defined charts, or
begin building a new
chart.

Opens Real Time for current prices and news.

Open Screen: open pre-defined screens, or begin developing
a new screen.

Chart Assistant: 
develop custom
charts, then define
your screening
criteria.

Company Highlights: run a financial highlights report for
one or more companies.

Open Report: open pre-defined reports, or begin building a
new report.

Launch Market Insight

Launch Library
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The Research Assistant
The Research Assistant is a wizard designed to walk you through screening the database. The
Research Assistant can also link to other wizards in Research Insight to build reports or charts
with the results of your database screen. For more information on how to screen the database
with the Research Assistant, see Chapter 3 - Screening COMPUSTAT (Global) With the
Research Assistant. 

Following is a description of each version of the three Research Assistant windows.

Research Assistant - Step 1 Window

This window lets you search for companies using specific screening criteria. You can conduct a
broad search for companies that are in the same industry sector, economic sector, SIC or NAICS
Code or country. 

Using the Change Set feature, you can narrow your search criteria by selecting a specific set of
companies as your starting point (e.g. S&P Euro 350). Search criteria can be narrowed further
by using the tabs on the right side of the window, checking the necessary fields under each tab
and selecting the ranges from the drop down lists. 

Enter
company
tickers here

Change the
initial set of
companies here

Narrow your
screening criteria
here

Select one
to compare
similar
companies
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Following is a description of each button displayed in this window:

Opens the Look Up List where you can search for a company name 
or ticker.

Opens the Initial Set dialog box where you can choose a set of 
companies as the starting point for your screen.

Opens the File Open window, which allows you to open predefined or
previously saved screens.

Erases all information displayed in the window.

Opens the Research Assistant - Step 1 Classic View window, which
allows you to access the advanced screening interface.

Restores the default settings of the window.

Saves your screening criteria for use in future analysis.

Saves your screening criteria with a specific name in a specific 
location.

Opens the Custom Indicators window, which allows you to customize 
your Indicator Groups (e.g. Valuation, Market, etc.) and Indicator Items
(e.g. Beta, Sales, etc.).

Opens the Research Assistant - Step 2 window.

Closes the Research Assistant.

Displays Help for the window you are in.
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Research Assistant - Step 1 - Classic View Window

This window allows you to view and modify the underlying Base Set and Formulas used in
developing your screen. To modify information, click on the field, enter the new information on
the command line and press Enter on your keyboard. This window is accessed by clicking the
Classic View button on the Research Assistant - Step 1 window. If you make modifications in
this window, you cannot return to the Research Assistant - Step 1 window. Following is a
description of each button displayed in this window:

Opens the File Open dialog box, where you can open predefined or
previously saved screens. 

Returns you to the Research Assistant - Step 1 window (only if you
have not modified any information).

Erases all the information displayed in the window.

Restores the default settings of the window.

Calculates the results of your screen.

Calculates your results for a specific time period.

Prints the formulas used in developing your screen.

Saves your screening criteria for use in future analysis.

Saves your screening criteria with a specific name in a 
specific location.

Opens the Research Assistant - Step 2 window.

Enter your
base set
information
here

Enter your
formulas
here
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Research Assistant - Step 2 Window

This window displays your screening results based on the criteria established in the first Research
Assistant window. In this window, you can add companies to your set or remove any companies
you do not want included in your set. You can also display the set by company name or ticker
symbol. 

Following is a description of each button displayed in this window:

Opens the Lookup List where you can search for a company 
name or ticker symbol.

Adds the ticker in the Add Company to set field to your set.

Saves your set or your screen.

Allows you to save your set or your screen in a specific location with a 
specific name.

Restores your set to the last version saved.

Removes the highlighted company from the Company List and from 
the Added Companies list.

Removes the highlighted company from the Company List.

Inserts the highlighted company back into the Company List.

Launches Market Insight, which gives you on-line access to 
up-to-date financial information through reports such as Country 
Overviews, Risk Reports, Company Profiles, Balance Sheet Statements,
Income Statements, and Financial Analysis Reports. Note: Market
Insight requires a separate subscription from Research Insight.

Add
companies
to your set
here

Companies
added to
your set are
displayed
here

Companies
removed from
your set are
displayed
here

The set of
companies
that passed
your screen
appear
here
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Returns you to the previous window (Research Assistant - Step 1).

Opens the Research Assistant - Step 3 window. 
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Research Assistant - Step 3 Window

This window links the Research Assistant to additional Research Insight functions such as
building customized reports or charts, opening pre-defined reports or charts or running a
Company Highlights report. The Report and Chart Assistant options take you to wizards
that allow you to build customized reports or charts. The Open Report and Open Chart
options allow you to run a pre-defined report or chart. The Company Highlights option
runs a company highlights report. Selecting Finish returns you to the Research Insight desktop. 

Following is a description of each button displayed in this window:

Returns you to the previous window (Research Assistant - Step 2).

Opens the next window based on the selection made.

Select another
Research Insight
function here
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The Report Assistant
The Report Assistant is a wizard designed to walk you through building and running custom
reports. Depending upon which type of custom report you choose to work with, the Report
Assistant can consist of up to three windows. The Report Assistant can be used as an extension
of the Research Assistant to build a custom report with the results of your database screen or by
itself with the aid of the Run Assistant as the method you use to screen the database. For more
information on how to work with a custom report using the Report Assistant, see Chapter 4 -
Reports. 

Following is a description of the three Report Assistant windows.

Report Assistant - Step 1 Window

This window is used to define specific report parameters when building your own report. It
displays when you choose the Report Assistant option on the Research Assistant - Step 3
window or when you click the Report Assistant button on the Research Insight desktop. You
can create a report using the current time period, or you can choose to compare data items and
companies over a specified period of time with an historical analysis report. If you are building a
report for the current time period, and you select Companies vs. Items, you can choose to
display multiple companies in your report by entering the number of companies in the
Company Count field. 

Following is a description of each button displayed in this window:

Returns you to the previous window.

Opens the Report Assistant - Step 2 window. 

Select a
format for
reports run in
the current
time period

Click here
to begin
creating a
free-form
report

Select a
format for
reports run
for a specific
period of time

Shows how your
report will be
formatted

If you selected
Companies vs.
Items under
Current Time
Period, enter the
number of
companies to
include in your
report here
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Report Assistant - Step 2 Window

This window is used to select the broad Item Groups and specific data Items within a
group/category that you want to appear in your report. Following is a description of each button
displayed in this window:

Adds new items chosen from the Look Up List to the Selected Items area. 

Opens the Look Up List where you can search for a specific item to add 
to your report.

Opens the Customize Item Sets dialog box where you can modify or 
create new item sets and items.

Adds the items selected from the Items area to the Selected Items area.

Adds all the items displayed in the Items area to the Selected Items area, 
which displays all items that will appear on your report.

Removes any highlighted item(s) from the Selected Items area.

Opens the Item Set Definition dialog box, where you can modify the highlighted 
Selected Item.

Opens the Item Definition dialog box where you can view the 
definition of the highlighted Item

Returns you to the Report Assistant - Step 1 window.

If you are running an historical analysis report, this button displays and takes 
you to the Report Assistant - Step 3 window.

If you are running a current time period report, this button displays and takes
you to your completed report.

Adds the items you used to screen the database to your report.

Moves the selected item up or down one position in the list; this affects where 
the item will appear in the report. 

Select the
broad Item
Groups and
specific
data Items
to include in
your report

Displays the
selected
item’s
mnemonic

You can add
other items or
functions to your
report here

The items you
have added will
appear here

Displays the
selected item’s
mnemonic
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Report Assistant - Step 3 Window

This window displays after you choose to build a report based on an historical analysis and
select the item categories and specific items within a category that you want to appear on your
report. This window lets you enter the Beginning and Ending Periods you want to use when
you run historical analysis reports. 

This window also gives you the option of selecting a Relative, Absolute or Calendar time
period for your report. 

The Relative time period requires a point of reference in order to determine exactly what time
period is being referenced (e.g. the last three years, the most recent four quarters, etc.). Relative
enables you to rerun your report in subsequent periods without changing the reference. The
default Beginning and Ending periods are 0 where 0 represents the most current time period
(e.g. annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period tells the exact time period and ensures that a specific time period’s
data is returned (e.g. May01 for May 2001 or Y01 for fiscal year 2001).  

The Calendar time period is an exact calendar year, quarter, month, week, or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001. The calendar time period for annual data is 2001. 

Standard & Poor’s Research Insight - Getting Started (Global)

Enter the
Beginning and
Ending Time
Periods for
your report

Choose a
Relative,
Absolute or
Calendar
format

Select the
alignment to
apply to all the
items here 
(e.g. Annual,
Quarterly,
Monthly, etc.)
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If you have selected data items with different periodicities (e.g. annual sales, quarterly EPS), this
window will also prompt you to select an alignment for the data. 

Following is a description of each button displayed in this window:

Returns you to the previous window (Report Assistant - 
Step 2).

Displays the Run Assistant window or your completed report, 
depending upon from where you accessed the Report Assistant.



Standard & Poor’s Research Insight - Getting Started (Global)

18

Report Window

This window displays a report according to the companies and criteria you established in the
Research and Report Assistants. Under the File menu, you can choose to Close or Save your
report; create a New report; or Open an existing report. If you close or save your file, you will
be taken out of the Research Assistant. 

Click the       (ReRun) button to access the Report Assistant where you can modify your report
parameters. Click the       (Run) button to access the Run Assistant window where you can
modify your screening criteria for the report. To return to the Research Assistant click the
(Research Assistant) button on the desktop.

Click here
to display
the report,
or its
underlying
formulas
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The Chart Assistant
The Chart Assistant is a wizard designed to walk you through building and running custom
charts. Depending upon which type of custom chart you choose to work with, the Chart
Assistant can consist of up to three windows. The Chart Assistant can be used as an extension of
the Research Assistant to build a custom chart with the results of your database screen or by
itself with the aid of the Run Assistant as the method you use to screen the database. For more
information on how to work with a custom report using the Report Assistant, see Chapter 5 -
Charts. 

Following is a description of the three Chart Assistant windows.

Chart Assistant - Step 1 Window

This window is used to define specific chart parameters when building your own chart. It
displays when you choose the Chart Assistant option on the Research Assistant - Step 3 window
or when you click the Chart Assistant button on the Research Insight desktop. You can select
the chart style along with how many companies are to appear on the chart. In addition, you can
create a chart using the current time period, or you can choose to specify period of time for an
historical analysis chart. Following is a description of each button displayed in this window:

Returns you to the previous window.

Opens the Chart Assistant - Step 2 window. 

Select
a chart
style
here

Select one
or multiple
companies
to display
in your
chart

Displays what your
chart will look like

Select a time
period here

Select a time
reference here
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Chart Assistant - Step 2 Window

This window is used to select the broad Item Groups and specific data Items within a
group/category that you want to appear on your chart. Following is a description of each button
displayed in this window:

Adds new items chosen from the Look Up List to the Selected Items
area. 

Opens the Look Up List where you can search for a specific item to 
add to your chart.

Opens the Customize Item Sets dialog box where you can modify or 
create new item sets and items.

Adds the items selected from the Items area to the Selected Items area.

Adds all the items displayed in the Items area to the Selected Items 
area, which displays all items to appear on your chart.

Removes any highlighted item(s) from the Selected Items area.

Opens the Item Set Definition dialog box, where you can modify the
highlighted Selected Item.

Opens the Item Definition dialog box where you can view the 
definition of the highlighted Item

Returns you to the Chart Assistant - Step 1 window.

If you are running an historical analysis report, this button displays
and opens the Chart Assistant - Step 3 window.

If you are running a current time period report, this button displays 
and opens your completed chart.

Adds the items you used to screen the database to your chart.

Moves the selected item up or down one position in the list; this 
affects where the item will appear in the chart.

The items you
have selected for
your chart
appear here

The mnemonic
for each selected
item appears
here

You can select
additional items
not displayed on
the screen using
the Look Up List

Activate these
general item
groups and
then select
specific data
items to
include in your
chart
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Chart Assistant - Step 3 Window

This window displays after you choose to build a chart based on an historical analysis and select
the item categories and specific items within a category that you want to appear on your chart.
This window lets you enter the Beginning and Ending Periods you want to display when
you run historical analysis charts. 

This window also gives you the option of selecting a Relative, Absolute or Calendar time period
for your chart. 

The Relative time period requires a point of reference in order to determine exactly what time
period is being referenced (e.g. the last three years, the most recent four quarters, etc.). Relative
enables you to rerun your report in subsequent periods without changing the reference. The
default Beginning and Ending periods are 0 where 0 represents the most current time period
(e.g. annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period tells the exact time period and ensures that a specific time period’s
data is returned (e.g. May01 for May 2001 or Y01 for fiscal year 2001).  

The Calendar time period  is an exact calendar year, quarter, month, week, or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001.  The calendar time period for annual data is 2001. 

Enter the
Beginning and
Ending Time
Periods for your
chart

Choose a
Relative, Absolute
or Calendar
format

Select the
alignment to apply
to all the items
here
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If you have selected data items with different periodicities (e.g. annual sales, quarterly EPS), this
window will also prompt you to select an alignment for the data. 

Following is a description of each button displayed in this window:

Returns you to the previous window (Chart Assistant - Step 2).

Displays the Run Assistant window or your completed chart, 
depending upon from where you accessed the Chart Assistant.



Chapter 2 - Navigating Research Insight

23

Chart Window 

This window displays a chart. according to the companies and criteria you established in the
Research and Chart Assistants. Under the File Menu, you can choose to Close or Save your
chart, create a New chart, or Open an existing chart. If you close or save your file, you will be
taken out of the Research Assistant. 

Click the       (ReRun) button to access the Chart Assistant where you can modify your chart
parameters. Click the       (Run) button to access the Run Assistant window where you can
modify your screening criteria for the chart. To return to the Research Assistant click the
(Research Assistant) button on the desktop. 

Below is a description of each chart toolbar button.

Copies chart to the clipboard as a bitmap

Copies data to the clipboard as text

Modify chart style

Rotates chart

Zoom

Z-clustered series

Show or hide legend

Vertical grid

Edit titles

Change fonts

Change colors and patterns

Displays chart properties dialog box

Horizontal grid

Show or hide series legend

Switches between 2-D and 3-D views

Select viewing
options here

Click here to
view multiple
companies by
Ticker or Name

When running a chart
for multiple companies
click on a ticker or
name to display the
chart for that company

Modify chart
attributes here
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File Open Window

This window displays when you choose the Open Report or Open Chart option on the
Research Assistant - Step 3 window or when you click the Open Report or Open Chart
button on the Research Insight desktop. From this window you can open predefined reports or
charts. Following is a description of each button displayed in this window:

Allows you to open files residing in other drives

Opens the Report Assistant - Step 1 window where you can 
create your own report.

Opens the Chart Assistant - Step 1 window where you can 
create your own chart.

Returns you to the previous window.

Runs and displays the highlighted report or chart.

Click on the
folders to
display all
predefined
reports and
charts



The Run Assistant
After you develop a custom report or chart with the Report or Chart Assistant, the Run
Assistant opens automatically so you can screen the database and view the results in your report
or chart. The Run Assistant window also displays after you have selected a pre-defined report or
chart from the File Open window or when you click        (Run) to re-run a report or chart. 

The Run Assistant does not guide you from one window to another. Instead, it has four stacked
tabs in one window, each of which you must click to access. With the Run Assistant, you can
create or modify the screening criteria, choose or change the set, modify the time period, or view
and change the underlying Base Set and Formulas for a report or chart.

Run Assistant - Screen

The Run Assistant - Screen tab allows you to create or modify the database screening criteria for
the report or chart you want to run or re-run without using the Research Assistant. This tab
contains all the same buttons as the Research Assistant - Step 1 window except for the Next
button. Instead, it contains the OK button, which runs the report or chart according to the
screening criteria you just defined in the Run Assistant window. See page 9 for a description of
the remaining buttons.
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Run Assistant - Set

The Run Assistant - Set tab allows you to choose or change the set of companies for the report
or chart you want to run or re-run. This tab contains all the same buttons as the Research
Assistant - Step 2 window except for the Next and Back buttons. Instead, it contains the OK
button, which runs the report or chart according to the set you just chose in the Run Assistant
window. See page 11 for a description of the remaining buttons.
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Run Assistant - Report Time Periods

The Run Assistant - Report Time Periods tab allows you to modify the time period for the
report or chart you want to run or re-run. This tab functions like the Step 3 windows of the
Report and Chart Assistants. It gives you the option of selecting a Relative, Absolute or
Calendar time period for your report or chart. 

The Relative time period requires a point of reference in order to determine exactly what time
period is being referenced (e.g. the last three years, the most recent four quarters, etc.). Relative
enables you to rerun your report in subsequent periods without changing the reference. The
default Beginning and Ending periods are 0 where 0 represents the most current time period
(e.g. annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period tells the exact time period and ensures that a specific time period’s
data is returned (e.g. May01 for May 2001 or Y01 for fiscal year 2001).  

The Calendar time period is an exact calendar year, quarter, month, week, or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001.  The calendar time period for annual data is 2001. 
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Run Assistant - Screen - Classic View

The Run Assistant - Screen - Classic View tab allows you to view and change the underlying
Base Set and Formulas for the report or chart you want to run or re-run. This tab contains all
the same buttons as the Research Assistant - Step 1 - Classic View window except for the Next
and Back buttons. Instead, it contains the OK button, which runs the report or chart
according to the Base Set and Formulas you just viewed or defined in the Run Assistant window.
See page 10 for a description of the remaining buttons.



The Look Up List
The Look Up List is a Research Insight tool that enables you to look up information about the
sets, companies, items, and functions included in the database. Like the Run Assistant window,
the Look Up List is comprised of four stacked tabs. It displays when you select Look Up from
the Tools menu or whenever you click the        (Look Up) button. 

The Look Up button is found throughout Research Insight and if you access the Look Up List
with the button, the contents of the list changes according to where the button is located. 

For example, if you click the Look Up button in the upper right-hand corner of the Research
Assistant - Step 2 window, the Look Up List displays with only the Look Up - Companies tab. 

If you click the Look Up button on the Initial Set dialog box, the Look Up List displays with
only the Look Up - Set tab. 

If you click the Look Up button in the upper right-hand corner of the Report Assistant - Step
2 window, the Look Up List displays with the Look Up - Items and the Look Up - Functions
tabs. 

However, if you access the Look Up List from the Tools menu, with the Look Up button on
the Research Insight Desktop or from the Research Assistant Classic View, it displays with all
four tabs.

Buttons

All four tabs in the Look Up List contain most of the same buttons. Following is a description
of the buttons common to all tabs in the Look Up window.

Pastes the company, set, item or function into the field from which
you accessed the Look Up List.

Copies the company, set, item or function to your computer’s
clipboard so you can paste it wherever you want.

Closes the Look Up List.

Displays Help for the window you are in.
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Look Up - Companies

To open the Look Up List from the Tools menu, select Look Up.

The Look Up - Companies tab lists every company, index, and currency in the COMPUSTAT
(Global) database by GVKey (a numeric identifier) and name, and by the set to which they
belong. With the Look Up - Companies tab, you can search within a set for a company using
the partial or whole name and you can look up the industry segment information for a
company, as well.  This tab allows you to sort the companies within a set by either tickers
(GVKeys) or names.

The Look Up - Companies tab contains all the buttons common to the Look Up window. In
addition, it contains the Segments button, which accesses the Segments dialog box so you can
view the industry segment information for a company.
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Look Up - Items

To open the Look Up List from the Tools menu, select Look Up.

The Look Up - Items tab lists every data item and concept within the database by category, by
name, and by mnemonic. With the Look Up - Items tab, you can search within a category for
an item using the partial or whole name and you can look up the data definition for the item, as
well. This tab allows you to sort the items within a category by either mnemonic or name.

The Look Up - Items tab contains all the buttons common to the Look Up window. In
addition, it contains the Definition button, which accesses the COMPUSTAT (Global) Data
Definitions window so you can view the definition of the item with examples.
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Look Up - Functions

To open the Look Up List from the Tools menu, select Look Up.

The Look Up - Functions tab allows you to look up the different categories of functions within
the database and the functions within the category. With the Look Up - Functions tab, you can
search within a category for a function using the partial or whole name, as well as review the
definition for the function.

The Look Up - Functions tab contains all the buttons common to the Look Up List. In
addition, it contains the Definition button, which accesses the COMPUSTAT (Global) Data
Definitions window so you can view the definition of the function with examples.
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Look Up - Sets

To open the Look Up List from the Tools menu, select Look Up.

The Look Up - Sets tab lists the sets available within the database by name and by category.
With the Look Up - Sets tab, you can search within a category for a set using the partial or
whole name, and you can look up any sets you have stored outside the database on your
computer or network and add them to them the database.

The Look Up - Sets tab contains all the buttons common to the Look Up window. In addition,
it contains the Browse button, which accesses the Open dialog box so you can view any sets
you have stored outside the database and add them to the database, if necessary.




